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— Barbara Blowes

From  the President
SeniorNet Mac Inc. PO Box 475

Christchurch 8140
41 Essex Street, Christchurch

Web: http://seniormac.org.nz/

Pop in and have a cuppa in 
the learning centre. You 

can get answers to computer 
problems, ask questions and get 
advice. If you need to bring in 
your computer please ring:

03 365 1979 
and leave a message

Items that can be solved quickly 
will be $5 but problems requiring 
significant time will attract up to 
$20 workshop charge.

The SeniorNet Mac Apple NEWS 
is distributed bimonthly on 10th 
April, June, August, October, 
December and February. You 
will be kept updated on important 
matters  with a Mini Newsletter 
by email every week, in between 
times.

Morning Sessions
MONDAY, WEDNESDAY,

 and FRIDAY 10.00 am to 12 Noon

SeniorNet Mac, Christchurch Executive and Committee

John Hampton	 Patron

Committee Members for 2019/20 are:
Barbara Blowes	 President	 president@seniormac.org.nz 
Charlie Millar 	 Vice President 	 vice.president@seniormac.org.nz
Elizabeth Chesney	 Secretary	 secretary@seniormac.org.nz
Elizabeth Chesney	 Treasurer 	 treasurer@seniormac.org.nz
Derek Brown	 Trustee
Brian Henderson	 Fundraiser	 funds@seniormac.org.nz
Erika White	 Events Manager	 events@seniormac.org.nz
Barbara Robinson	 Customer Services	 services@seniormac.org.nz
Christene Berry	 Member
Robin Harrington	 Bookings	 bookings@seniormac.org.nz

Ross Beach 	 Editor	 editor@seniormac.org.nz

We had a very interesting speaker Bronwyn Groot 
at our monthly July social. Bronwyn's talk was 

about all the types of SPAMS and SCAMS that are 
doing the rounds at the moment. Two of the scams that 
she talked about I had never seen or heard of so we all 
have to be very vigilant in this digital world. 
Why I am writing about this to you is that over the last 
two weeks I have heard of three people who have been 
scammed with the latest SPARK phone call or email. 
Spark ring you up, probably catch you when your guard 
is down, or you are feeling depressed with life's problems and you are very easy 
prey in these circumstances.The people I have heard of have been scammed out 
of a lot of money (thousands) not something you would feel good about at all.You 
will need to have your computer professionally cleaned at a cost, you have to deal 
with your bank and all through this stressful time you have to tell your families 
what has happened. I really feel for you if this happens but please I can’t stress 
enough if you get any emails that you are not sure about the sender hit DELETE. 
Any phone calls from SPARK, HANG UP, don't have a conversation with them they 
are only after your MONEY.
If you need help about any of these scams please contact SeniorNet Mac or ring 
me. Please don’t get caught, be very careful.
I am ordering more copies of Bronwyn's LITTLE BLACK BOOK on SCAMS and I 
will let you all know when there will be free copies of this book at our Learning 
Centre.   �

PUBLIC NOTICE: Due to recent budget cuts, the rising 
cost of electricity, gas, oil, plus the current state of the 
economy, the light at the end of the tunnel has been 
turned off.—Have a Nice Day
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Deadline for October/November Apple NEWS

September 28th
Please have your copy for the next Apple NEWS to me 
by the above date.
Copy can be either typed straight into an email, as a 
Word file or as Rich Text Format.
Digital images need to be at least 220dpi  or higher 
(72dpi will not reproduce well)
Please no hard returns except at the end of a 
paragraph.

Hi there.
Here we are into August, our 
Daffodils are out, and so far 
we have had a fairly mild 
winter. The Black Caps lost 
the Cricket World Cup final in 
a fiasco result, but the sun still 
comes up every morning and 
goes down in the evening just the 
same. The Crusaders got their 3 

peat, the Silver Ferns are now World Champions once again. 
The All Blacks have had a narrow win and a draw. The UK 
have a new Prime Minister, (where to now with Brexit?). In 
this issue of Apple News we have the regular features—
From the President, Profile, Brian the Pirates tips, Courses 
and Workshops, Members Photo Corner. I have begun a 
new series on Typefaces with Part One (further Parts in the 
coming months). Tech Tips from Pam Doughty, and an article 
supplied by a SeniorNet Mac 
Member plus details on "Kanopy" 
a new download service available 
to Members of the Christchurch 
City Libraries. Also an excellent 
article from Bronwyn Groot on 
Spams and Scams.     � 

Welcome to New Members

EditorialContents

Lynn and Graham King, Charlotte Rivers
Out of my mind...
Back in 5 Minutes
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No liability is accepted for any errors or omissions or inadvertent disclosure not meant for publication. Any opinions 
expressed may not necessarily reflect the views of the Editor or SeniorNet Mac Inc. who, likewise, neither endorse nor 
accept responsibility for products or services of any advertisers or for opinions expressed within the Apple NEWS.

Every effort has been made to ensure that no known copyright issues have been breached and 
that appropriate acknowledgements have been made, with regard to all articles and advice 
given in this publication.

Disclaimer

APPLE USER GROUP               Cookin’ with
Canterbury Apple Users 

is a subgroup of Christchurch SeniorNet Mac Inc. and 
meets on the last Wednesday of each month at the 
SeniorNet Mac Rooms, 41 Essex Street, Christchurch.  A 
heated room with all conveniences, tea/coffee and bikkies. 
FREE to SNM members. General public $4.00
It has its own web site called www.appleusers.co.nz The 
free HELP email list is open to all Mac users who wish to 
give or receive assistance. See on the website under ‘email 
list’ for instructions on how to subscribe or unsubscribe to 
this service.    �

Our Sponsors

Also in association with:
The Federation of NZ SeniorNet Societies

Community Organised 
Grants Scheme

WANTED

•	Web Advertising on our Web Site
•	Apple NEWS Advertising
•	Reasonable Rates: For prices contact:

Customer Services
03 365 1979

services@seniormac.org.nz

Advertisers Our Direct banking number is 020816-0376043-00

PLEASE when paying monies to SeniorNet Mac, 
include as reference either your Name 

or Membership Card number.
We are receiving credits from time to time from 
unknown members.
We have no way of telling who they are from.
Your Membership card has a unique number and 
should begin with the figure 4

Elizabeth Chesney
Treasurer@seniormac.org.nz

IMPORTANT

INTERNET  BANKING

APPLE BUTTER-SCOTCH PIE

Take 6 or 8 apples, 1½ cups brown sugar, 
1 cup of water, 1 teaspoon of vanilla, 4 
tablespoons of flour, 2 tablespoons butter, 2 
teaspoons vinegar,  a pinch of salt.

Cook half the sugar with water and vinegar 
until it boils, add apples (cut fairly large) 
and cook until tender. Remove apples. Mix 
remaining sugar with flour and salt, add 
slowly to syrup until it thickens. Remove 
from stove, add butter and vanilla, let cool. 
Line deep pie dish with pastry, fill with the 
apples, pour over the butter-scotch mixture. 
Place criss-cross strips of pastry on top, 
Bake in a fairly hot oven.    �
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Introduction
Today in this digital era, you are overwhelmed by 
a proliferation of typefaces—TV Adverts, Posters, 
Signage of every description, Brochures, Magazines, 
Books and Book Jackets, Newspapers, Shop signs, 
Road signs—in fact everywhere that you look there 
will be typefaces.
When I began my apprenticeship as a Hand 
Typographer in 1952, there were only typefaces used 
in Newspapers, Invoices, Statements, Invitations, 
Shop signs, Posters, Books and Magazines. And most 
of those typefaces were Sans Serif, Serif, Scripts and 
Blackletter (more commonly known as Old English).
Though the firm that I was working for had a much 
wider selection than most printers, due to my 
employer on a visit to the USA in the early 1920s 
importing a wide selection of American typefaces. 
Today in this digital era I have available on my 
personal computer over 1000 diferent typefaces 
which I have collected over the last 28 years.

The Basics of the different typefaces
They are Serif, Sans Serif, Scripts and Blackletter.

Examples of Serif faces 0 indicates the Serif—

Examples of Sans Serif—

Examples of Scripts—

Helvetica • Baskerville • Univers • Bodoni • Arial • Times 
 Tekton • Brush Script • Goudy • Chopin Script • Garamond 
Snell Roundhand • Zapf Chancery • Mona Lisa • Rockwell 

 Caslon  Park Lane • Perpetua • Zebrawood  Gill • Mistral
Fette Fraktur• Thorne Shaded

Bernhard • Lithos Pro • PLAYBILL • Stencil• Penhurst
Goudy Text •Baskerville • Reisling •Marker Felt • rialto

Typefaces

Baskerville   Times  Goudy
Bodoni  Garamond  Caslon0

0

00 0

Helvetica  Univers  Arial
Gill Sans  Futura

Snell Roundhand   Chopin Script
Baroque Script  Shelly Volante Script

Examples of Brush and Freehand Scripts—
Brush— 

Freehand—

Examples of Black Letter—

Those are the basic typefaces, obviously there are many 
more—in the next installment I will  give you more, such 
as Display faces, Decorative faces, Modern faces—and 
discuss their origins and tell you what are my favourites, 
why they are my favourites.    �

Ashley script   Mistral   Reporter  
Brush Script

New Berolina  Savoye  Tekton Oblique  
Ruling Freestyle

Goudy Text   Fette Fractur  
Notre Dame   San Marco

Wittenberger Fractur

Part One
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Photo Corner

Dale Chihuly  Glass Exhibition, 
New York, Bronx Botanical Gardens,

(photos taken by Erika White during her visit in September 2017)

Blown Glass Art

Macchia Forest appears molten, especially 
when illuminated at night. 

This creation is called White Belugas (white 
whales) so graceful and delicate. 

Citrus Fruit—Sol del Citron. Garden Fiori adds a magical display of art and light 
to the surrounding natural specimens.

Members

Artist Dale Chihuly returned to New York City with his first show in ten years: a grand exhibition in the New York Botanical Garden 
(NYBG). The showcase, titled CHIHULY, includes glasswork sculptures that will be radiating throughout the gardens all summer long, 
by day and night. With site-specific installations, CHIHULY aims to interact with the landscape of the gardens to build a dialogue 
between movement, color, and light. (Google: “Chihuly Glass Exhibition New York” for more amazing photos)



Page 7Helping Seniors with Apple Technology  http://seniormac.org.nz

Creating Animated Titles in 
Keynote for iMovie
—courtesy SeniorNet Mac member Joe Adams 
Open Keynote
(1)	 Select Theme and wide screen

(2)	 Remove Sub-title box and type in title in large top box 
on screen.

(3)	 Make this text box full screen .

(4)	 Increase type size to fill space and type title and style 
- around 500 points ideal.

(5)	 Centre vertically and SET COLOUR TO GREEN - this is 
important.

(6)	 Now select Build-in animation at top right panel (eg 
Swoosh) and set duration (maybe 8 sec)

(7)	 Next set animation (eg maybe pop and duration 9 
ideally 4 sec)

(8)	 Now choose Build-out animation (say Skid) and ensure 
Playback settings are on Self Play.

(9)	 Go to File and Export to Animated clip< choosing Tiff 
and 1080 and a movie will build.

(10)	 Now minimise or close Keynote.

Open iMovie
(11)	 Create New Project,  Select and import first clip.

(12)	 Find Title Clip seated in Keynote, drag in to timeline 
ABOVE clip, Select and click Greenscreen.

(13)	 Use Greenscreen erase button and click on Title.

(14)	 Trim or extend both clips to suit and your movie is 
now ready to be built or added to.    �

Hi my name is Andrew Grant

Profile

I was born in Christchurch in 1948; my mother was also born in Christchurch; my 
father was from Scotland. Growing up, when I heard a pipe band I would always 
try to get to the front of the crowd to watch them play. In the late fifties my father 
managed to get me into the Irish Society Pipe Band here in Christchurch, the only 
one in NZ. Dad was the bass drummer for the band, which was quite funny as he 
was Scottish.
In 1966 I started work as an apprentice at Suckling Brothers Shoe Factory in Dundas 
Street. I worked there for a number of years, while still playing the bagpipes on and 
off. Then in 1980 I joined the Canterbury Caledonian Society Pipe Band grade 3
I worked my way up to being Pipe Major.
The Caledonian Pipe Band then started a grade 4 band, so I moved there and 
became Musical Director. We had really good results as I had a good team with me. 
They then decided to change the uniform from military uniform to alternative. With a 
bit of knowledge working with leather I said to the committee that I could make new 
sporrans and waist belts for the grade 3 and 4 bands. That’s how I started making 
sporrans and belts for other bands. Then I looked at different types of sporrans such 
as day type sporrans, semi dress, and dress also children’s sporrans.
So it turned out I was making sporrans for: Canadian, Australia, and New Zealand 
Pipe Bands.
Now that I have retired, I no longer play the pipes and I am also cutting back on 
making sporrans and waist belts. I have now joined Santa’s Work Shop making 
wooden toys for underprivileged children.    �
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Tech Tip Tips from Pam Doughty
courtesy AUSOM News, 2019

4
Draw within Notes — iOS12
NOTE: I have only tried this on an iPad.
There is a distinct difference between adding a Sketch 
Object and Drawing on a Note on the iPad.

Tapping on the pen/pencil icon (as shown above or located 
on the on-screen keyboard) brings up many tools but there 
is no ruler and no ‘selection’ tool.
Drawing this way allows more control over the various tools 
and provides a pop-up palette area to select colours.

If you need the ruler then you need to add a Sketch Object
by tapping the +.

When you add a sketch this way the tools differ slightly— 
I cannot find how to control the 'width' of the lines created. 
Colours are selected by sliding left and right across the 
'dots'.

The ‘object’ created this way will be shown when you view 
the ‘attachments’ associated with your notes.

One final tip
When drawing on a Sketch Object you do not actually tap
the ruler icon to select it.
You can place the ruler on the screen by tap-and-hold
with, in my case, your left hand. Try it! The ruler will
appear.
Keeping hold of your ‘ruler’ you can move it around
until you are ready to draw beside it with the tool of your
choice (with your other hand).      �

iWork v Microsoft Office
Apple has a comprehensive set of tables showing the 
ways Pages, Numbers and Keynote support
popular Microsoft Office features at

https://www.apple.com/mac/numbers/compatibility/
�
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Information—Photos—Mac OS
Using Photos on your Mac you can view and add 
information about each of your photos (and in some cases 
if more than one photo is selected you can add the same 
information to each of the selected photos). For example, 
you can see details of the camera that took the photo, the 
date and time a photo was taken and assign captions/ 
descriptions and titles.
To view or change information for a photo, you open the 
photo’s Info window:
• Double-click a photo to view it,
• click the Info button in the toolbar or press Command-I.
• You can now alter any of the following:
Title: Enter a name in the Title field.
Description: Enter a caption in the Description field.
Keywords: Enter keywords in the Keywords field. As you 
start typing, Photos suggests keywords that you’ve used 
before. Press Enter when you’ve finished a keyword. To 
remove a keyword, select it and press Delete.
Favourite: Click the Favourite button to mark the photo 
as a favourite. Click the button again to unmark it. (The 
favourite button is a tiny heart shape).
Faces: Click the PLUS to Add a Face. Move the circular 
area (face identifier) over the photo and type a name to 
identify a face.
Click multiple times and drag the face identifier over 
different faces to identify multiple faces in a photo. As you 
start typing names, Photos will suggest names you have 
used before and/or names from your Contacts. Click the X 
in any face identifier to delete it.
Photos can display the title you assign to photos in 
the Info window, metadata (other information about 
each photo, such as its file type), and badges that 
identify whether the photo has been edited, had 
keywords added, and more. To ensure Photos display 
this information select View >Metadata > and tick the 
metadata name(s) you want displayed.

Change a photo’s date and time
You can change the date and time associated with 
a photo or a group of photos. You might want to do 
this if you travel to a location in another time zone, 
and your camera assigns your photos dates and 
times that are correct for your home, but not the 
place you visited.
• Select the photos you want to change.
• Choose Image >Adjust Date and Time.
• Enter the date and time you want in the Adjusted field.
• Click a time zone on the map, if necessary.
• Click Adjust.

Change a photo’s location
To adjust the location double-click the date and time field 
within the Information area. OR Select Image >Adjust 
Date and Time     �

Accessing tools: iWork apps — 
MacOS
When using Pages, Numbers or Keynote the Format side-
panel includes an Arrange tab giving options for positioning 
objects with precision.

To make the tools easier to access select Show Arrange 
Tools from the View Menu.

The tools are then available as a pane, which can be 
moved anywhere on your screen.

It is also possible to use this technique with Colours, 
Adjust Image and the Media Browser.    �
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GUEST 
SPEAKERS

24 September

27 August
Dr Geoffrey Rice 

Pictorial Overview of Lyttelton's history up to about 1990.
Dr GEOFFREY RICE is an independent historian who was formerly Head of History (2006-10) at 
the University of Canterbury, where he started as a student in 1965 and ended up as Emeritus 
Professor. He was general editor for the second edition Oxford History of New Zealand (1992). 
His more recent books have been in local and public history: Christchurch Changing: an illustrated 
history (1999) and Lyttelton, Port and Town (2004) have both been reprinted. The second edition 
of his definitive account of the 1918 influenza pandemic in New Zealand, Black November 
(2005), was shortlisted in the History section of the 2006 Montana NZ Book Awards. His more 
recent books include Victoria Square: Cradle of Christchurch (Canterbury University Press, 2014), 
Cricketing Colonists: the Brittan Brothers in Early Canterbury (2015), and a co-authored biography 
of Dr Leslie Averill (2018). He was secretary of the Canterbury Historical Association for 25 years, 
and is currently secretary of the Canterbury History Foundation. A condensed and updated version 
of Black November was published by Canterbury University Press in 2017 as Black Flu 1918. A 
collection of eye-witness accounts of the 1918 pandemic in New Zealand was published in 2018 
as That Terrible Time.     �

Dr Geoffrey Rice

Kanopy is an online video streaming service providing thoughtful entertainment aimed at adults 
and kids. Kanopy has more than 10,000 of the world’s best films, including award-winning 
documentaries, rare and hard-to-find titles, film festival favourites, indie and classic films, and 
world cinema with collections from Umbrella Entertainment, Madman Entertainment, Under the 
Milky Way, SND Films and thousands of independent filmmakers.
Sign up for an account and you will get 10 play credits per month. Once you press play on a video, 
you will automatically use one play credit. When you have selected a film, you have 3 days to play 
your selection as many times as you wish. Once you've used the 10 credits for the month, you 
won't be able to watch any films until your new monthly quota arrives on the first of the month.
Films can be streamed from any computer, television, mobile device or platform by downloading the 
Kanopy app for iOS, Android, AppleTV or Chromecast. Set up an account then login into the app.    �

Fed up with the Dross and Pap that Prime Time TV offers ?
If you are a member of Christchurch City Libraries—then this is your answer !

Kanopy is available through Christchurch City Libraries—contact them and with your 
Membership card plus a password they will sign you up for an account and give you 
instructions on how to Download etc.

New Horizons
This will be an enjoyable, interactive and interesting afternoon looking forward into the future of digital technologies and 
SeniorNet Mac’s place within it. Laugh, learn and have your say. Facilitated by members of the Committee.    �
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SeniorNet Mac  Social &
Luncheons

Ross Clendon

Raffle Results 
25 June

1st. Wendy Perkins

2nd Christene Berry

3rd Quoylene Hansen

Ross is a long-standing member of SeniorNet Mac and our honorary legal advisor, so it was 
a pleasure to hear about some of his background experiences when he and his family lived in 
Manilla, Philippines, from 1985 to 2005. As is often the case, his “trailing spouse” (Ross’ words, 
not mine) gave up her work in Wellington and moved the family, twin boys barely a year old, to 
be where Ross had been offered work as legal advisor in the Asian Development Bank (ADB).  
They went initially for 3 years and stayed 20, sending the twins back to New Zealand aged 13 
to live with their grandparents in Christchurch and have a more “normal” life rather than the 
“luxurious” life of expatriates in Manilla.  
The first part of Ross’ talk was about the nature and set-up of the ADB and the second part 
about his personal reflections on being an expatriate family in Manilla. It was not easy 
separating the two as they were so intertwined. He began by explaining that the ADB was set 
up mainly at the instigation of the Japanese in the same way the World Bank was set up after 
WWII to help nations get funds for rebuilding and development. The main goal was to alleviate 
poverty by providing low interest loans to the most needy areas of Asia, an area stretching 
from the edge of Europe in the West across the Baltic States, Mongolia, India, Indonesia, the 
Philippines, China, Japan and as far East as Samoa.  There are 64 nations who are members, 
including New Zealand, some as donors and others as recipients. The donor members 
underwrite the loans giving the bank credibility. While improvements have been made to reduce 
the number of people in abject poverty in this area, there is still a long way to go. Although 
China became and is still a member of ADB, it now has its own Development Bank centred in 
Beijing with 99 members across the world including the Americas with billions of dollars at its 
disposal.
Ross’ role was to ensure all the documentation regarding the loans was correctly set up. To do 
this he travelled extensively throughout the region but also went to the UK, US and Western 
Europe. His favourite among all the countries was Mongolia. At first he loved the travel but 
in later years he was ready to stay at home more often. His wife was very involved in the 
expatriate community as there were over 50 different nationalities working in the ADB and lots 
more in other sectors. She particularly enjoyed working voluntarily in the museum and helping 
to organise the bridge club. They had Philippino maids, gardeners and cooks to look after them, 
and then they in turn helped these Philippino families if there was need. They found the people 
of the Philippines were really friendly and hard-working.  Looking back, would he do it all again? 
His answer was yes but he was not sure whether his wife would give the same answer.     �

25 June

Bronwyn Groot

30 July We had a large attendance of 58 people at our July Social and Luncheon and an excellent 
speaker, in Bronwyn Groot who is a Fraud Education Manager. She advised everyone who 
attended of the different types of scams and by the look on their faces and the gasps from some 
of the audience I think they were flabbergasted at the number and different types of scams that 
are around today.    �

1st Judi Millar
2nd Lynne Grego

3rd Margaret Higgins

Raffle Results 
30 July

Sections of those attending enjoying their Lunch.
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SeniorNet Mac  Social &
Luncheons

"....and you say that you spent 6.35 years deleting spam from  your 
emails." 

Sections of a rapt audience during Bronwyn's Presentation
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Bronwyn Groot “Scams” — Fraud Education Manager
Commission for Financial Capability (CFFC)

Bronwyn has won several awards for protecting the elderly.

Dec 2018 losses of  $33 million 

Types of scams:		  Charity
			   Romance
			   Money Laundering
			   Investment 
			   Car Trading
			   Door-to-door
			   Tax
			   Health and Medical
			   Purchase of Merchandise
			   Subscription Traps
			   Emergency
			   Mobile Phones
			   Phishing & Smishing
 			   Identity Theft etc. ……….. All provide link sites to get information from YOU.

What to do when in doubt:
1.  Hover the mouse over the sender’s address to check if a genuine sender.
2.  Stop and THINK

Scammers want to isolate you. Currently the biggest scams from phone (landline), they try to keep you engaged (up to 8 
hours) while they work in the background collecting data about you. Basically they are trying to glean details of your bank 
account/credit card. Either hang up the phone or ask the scammer to call back, then ring your ISP and check.

Recovery room scams. This usually occurs some weeks/months after you have been previously scammed, the “new” 
scammer pretends to be from the police and details the previous scam and suggests knowledge of what they advised you 
to do including reporting to the police, cancelling the credit card, changing email address etc. All leading you on towards 
you providing details of your new credit card.

Every minute of every day huge amounts of data is exchanged.  

Subscription Traps:  Over 103 million letters are sent through the mail (snail mail) consisting of glossy brochures and 
follow-up type subscriptions.
Scams often include confidentiality clause.

What to do when you receive a scam or suspected scam:
1.   Show the fake letters to the police.
2.   Use a separate credit card with a low amount ie $500.00 for online shopping.
3.   Cars in Malls requiring you to fill out a form giving contact details etc. This data is on-sold.
4.   Beware of abuse from loyalty cards.

Fraudsters are real —You’re the target—Learn to fight fraud—Report it!

Protect yourself by seeking out more information ………… www.scamwatch.govt.nz

Tips to Protect Yourself
1.   Keep your computer systems up-to-date, reputable antivirus software and strong passwords.
2.   Validate all transfer requests either on the phone or in person. Never use the contact 
      information provided in emails.
3.   Verify the sender’s email address. Scammers may use similar addresses from legitimate ones.
4.   Limit the details you share publicly.   
								                                   Notes by Bryan Kelly  

�
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Example of  

an IRD Tax Scam
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 Courses &Workshops

WORKSHOP DESCRIPTIONS

SEPTEMBER
COURSE DESCRIPTIONS

WORKSHOPS

Skype/FaceTime.	 5th Sept.	 Thursday	 10 - 12 noon

iPad/ iPhone Introduction	 17th Sept.	 Tuesday	 10 - 12 noon

Updating to iOS 13	 19th Sept.	 Thursday	 10 - 12 noon

Family History	 26th Sept	 Thursday	 10 - 12 noon

For all of the above Courses, Workshops, Contact: bookings@seniormac.org.nz

or Phone 03 3651979 and leave a message. We will contact you as soon as possible.

We prefer that members with iPad and iPhones take an iPad/iPhone introductory workshop before taking any other course relative to 
their device. Please contact the teacher if you are confident that you have sufficient basic knowledge to move to the next level.                    

2 Week Courses:	 $20
Workshops:	 $10
One on One	 $20 per session

 Please pay at the start of your Course or Workshop. 
All Courses and Workshops held at the SeniorNet Mac Rooms, 41 Essex Street, Christchurch 

COURSES

iPad Basic	 2 weeks	 3rd Sept.	 10th Sept.	 Tuesday	 10 -12 noon

Mac Basic 2	 2 weeks	 11th Sept.	 18th Sept.	 Wednesday	 2 - 4 pm

iPhone applications	 2 weeks	 16th Sept.	 23rd Sept.	 Monday	 2 - 4 pm

iPad Basic.	 Basic operations for iPad
Mac Basic 2	 Using important apps, their setup/customisation 
iPhone apps	 How to use the key Apple provided applications on iPhones

Skype/ FaceTime	 Basic video conferencing applications
iPad /iPhone Introduction	 A basic introduction to the iPad and iPhone 
Updating to iOS13	 New features in iOS 13, iPad and iPhone 
Family History	 Discovering your ancestry
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 Courses & Workshops

October
COURSE DESCRIPTIONS

iPad Basic	 Basic operations for iPad
Mac Basic 1	 Introduction to Mac, Finder, Doc and running applications
iPhone apps	 How to use the key Apple provided application on your iPad under iOS13
Pages on the Mac	 Text formatting word processing/ page layout document settings and more

iPhone Basic	 2 weeks	 1st October	 8th October	 Tuesday	 10 - 12 noon

Mac Basic 1	 2 weeks	 2nd October	 16th October	 Wednesday	 2 - 4 pm  

iPad/iPhone apps	 2 weeks	 14th October	 21st October	 Monday	 2 - 4 pm

Pages on the Mac	 2 weeks	 23rd October	 30th October	 Wednesday	 2- 4 pm

COURSES

WORKSHOP DESCRIPTIONS

Apple T. V. and Netflix.	 Streaming video services
Simple word processing	 Getting ready for Xmas letters 
IPad/iPhone Introduction	  A basic introduction to the iPad and iPhone 
Reunion application	 Data base on family history

WORKSHOPS

Apple T.V. and Netflix	 7th October	 Monday	 2 - 4 pm

Simple word processing	 9th October	 Wednesday	 2 - 4 pm

iPad/iPhone Introduction	 17th October	 Thursday	 10 - 12 noon

Reunion application	 24th October	 Thursday	 2 - 4 pm

For all of the above Courses, Workshops, Contact: bookings@seniormac.org.nz

or Phone 03 3651979 and leave a message. We will contact you as soon as possible.

We prefer that members with iPad and iPhones take an iPad/iPhone introductory workshop before taking any other course relative to 
their device. Please contact the teacher if you are confident that you have sufficient basic knowledge to move to the next level.                    

2 Week Courses:	 $20
Workshops:	 $10
One on One	 $20 per session

Please pay at the start of your Course or Workshop. 
All Courses and Workshops held at the SeniorNet Mac Rooms, 41 Essex Street, Christchurch
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Brian the Pirate’s Tips

Tip #1 15 Keyboard Shortcuts Mac users need
Most Mac users know Command-C means Copy and Command-V means Paste, but 
there are many other useful shortcuts to make a Mac user’s life much easier:

Command + M
Press this combination to minimise the front app window to Dock, or press 
Command-Option-M to minimise all the windows belonging to the front app.

Command & Option
If you can’t see your desktop for all the open applications, just hold Command and 
Option down and click anywhere on your desktop. If you just want to get to all the 
open windows in any app, hold down the same keys and click on any available 
window for that app.

Command + Shift + A
When in Finder (Desktop view): 

Command + Shift + A  to get to your Applications folder 
Command + Shift + U to open your Utilities folder 
Command + Shift + D for Desktop 
Command + Shift + H for Home 
Command + Shift + I to access iCloud Drive

Command + Space
Opens Spotlight, and just start typing your query.

Command + L
The fastest way to make a search or navigate to a Website in Safari, Command-L 
instantly selects the address bar: start typing your query and select the appropriate 
choice using the up/down arrows on the keyboard.

Command + Tab
While keeping Command key pressed use Tab to navigate to the app you want to 
use.

Command + Option + D
Show or hide the Dock (applies to most apps)

Command + up arrow (or down arrow)
Use the Command key + up/down arrows to jump to the top or bottom of any 
page.
Another way is to use Control + Tab and Control + Shift + Tab.

Command-left/right arrows
Hit Command and the left arrow to go back a page in the browser window. Hit 
Command right to go forward again.

Try holding down either the Command key while holding down other keys and key 
combinations to see what they do. Then try holding down the Option Key and see what 
happens while holding down other key combinations - the results may surprise you! �
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Brian the Pirate’s Tips

Tip #2

HOW2 Limit Screen-Time in a Connected World

The world has become more connected than ever, in fact it breaths information overload. 
Children have countless options on how and when they connect to the internet.

It has easy to understand why limiting screen-time has become virtually impossible.
Connected devices such as computers, iPhones, iPads, smart TVs and gaming 
consoles, all have web browsers that anyone including children can use to surf the web.
This all makes it very hard to limit the time children spend online. 
In 2016 the American Academy of Pediatrics suggested changes and recommendations 
for screen-time viewing:

• Children under 18 months should avoid screen-time, other than video-chatting 
(perhaps to parents/grandparents).

• Children aged 18 months to 2 years watch or use high-quality programs or apps 
only if adults watch or play with them to help them understand what they’re seeing.

• Children aged two to five years should have no more than 1 hour a day of 
screen-time.

• Children aged 6 years and older should have consistent limits on the time they 
spend on electronic media and the types of media they use.

To date, Australian research has shown guidelines were being routinely broken by 
children, with 63% of children exceeding the recommended amount of screen-time.
For example, in 2016, children spent an average of 12 hours per week online and 10.5 
hours watching TV. Similar patterns can be seen with NZ children.

One suggestion was to control children’s use of the internet by controlling the time limits 
when children can go online on any of their connected devices at home. Parents must 
ensure their children are growing up healthy and getting a good night’s sleep.

Another major issue is that inappropriate content is now more available and accessible, 
than ever before, making it easy for curious children to stumble on something they 
should not be exposed to.

Parents can setting up filtering tools on computers and various other devices which use 
browsers to access the internet. The NetSafe website offers suggestions to help with 
monitoring children’s use of the internet. Often parents seek advice to curb cyber-bullying 
and educate children about safe social media usage particularly when they use apps 
where cyber-bullying could occur.

  <  netsafe.org.nz  >

�

Parents can set up filtering tools on computers and various other devices which use 
browsers to access the internet. The NetSafe website offers suggestions to help with 
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